
PETRIDOTNET 1.3 FELHASZNÁLÓI ÚTMUTATÓ 

Utolsó módosít{s: 2011. július 11. 

Aktu{lis programverzió: 1.3.4209 

I. Bevezető 

A PetriDotNet program Petri-h{lók szerkesztésére, szimul{ciój{ra és analízisére szolg{l. 

A BME Méréstechnika és Inform{ciós Rendszerek tanszékének szakmai segítségével készült 

azzal a céllal, hogy az oktat{sban is haszn{lható, könnyen kezelhető és bővíthető program 

legyen. 

 

II. Rendszerkövetelmények 

A PetriDotNet program futtat{s{hoz a Microsoft .NET (3.5 vagy újabb) keretrendszer 

szükséges Windows (XP vagy újabb) oper{ciós rendszer alatt. A fejlesztés közben arra töre-

kedtünk, hogy a program a Mono futtatókörnyezettel is kompatibilis maradjon, így Linux és 

Mac OS X platformokon is futtatható legyen. Azonban a Mono környezet nem tesztelt, így 

nem is t{mogatott. 

Kisebb méretű (néh{ny sz{z csomópontot tartalmazó) Petri-h{lók esetén a program 

memóriaigénye nem jelentős (10–20 MB nagys{grendű), ugyanakkor nagy (egy alh{lóban 

több ezer elem feletti) h{lók esetén m{r jelentős az erőforr{sigény, illetve ilyen méretű h{lók 

gyors megjelenítésére a program egyelőre nincs optimaliz{lva. 

A program nem igényel telepítést. A tömörített {llom{nyból kibontva, tetszőleges helyre 

m{solva futtatható. 

 

III. A program használata 

Igyekeztünk olyan programot készíteni, aminek haszn{lata könnyen és gyorsan elsaj{-

títható. Az al{bbiakban rövid betekintést nyújtunk a program kezelésébe, az egyes funkciók 

működésébe, a program különböző kezelőfelületeinek haszn{lat{ba. 

III.1. Indítás 

A PetriDotNet program indít{sa ut{n egy üres szerkesztőablak fogad: 
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A programot a főmenüből, illetve az eszközs{vról kiv{lasztott parancsokkal vezérelhet-

jük. Indít{s ut{n v{laszthatunk, hogy egy új üres h{lót készítünk (File » New parancs) vagy 

egy kor{bban elmentett h{lót töltünk be (File » Open parancs). 

III.2. Betöltés, mentés 

A program jelenleg kétféle f{jlform{tumot haszn{l: 

− .pnml: XML alapú szöveges f{jlform{tum. A PNML a Petri-h{lók szabv{nyos t{rol{si 

form{tuma, m{s Petri-h{ló programok is t{mogatj{k. Ennek a haszn{lata javasolt. 

− .pn: Bin{ris f{jlform{tum. Gyorsabb a betöltése, viszont az olvashatós{ga csak egy 

programverzión belül garant{lt. 

Ezen felül jelenleg egy tov{bbi f{jlform{tum érhető el beépülő kiterjesztés (add-in) for-

m{ban (az Add-in » Export menüpont alatt): 

− .pnt: az INA analízis program {ltal elfogadott form{tum. Ebbe a form{tumba mentve 

tudjuk a h{lót az INA programmal beolvastatni és a tulajdons{gait elemezni. 

III.3. Petri-hálók létrehozása, szerkesztése 

A PetriDotNet program több ablakos (MDI) szerkesztést tesz lehetővé. Azaz egyszerre 

több Petri-h{lót nyithatunk meg és szerkeszthetünk, a hozz{juk tartozó szerkesztőablakokat 

pedig a Window paranccsal tetszés szerint v{ltogathatjuk, illetve egym{shoz képest függőle-

gesen és vízszintesen elrendezhetjük. 

 

A szerkesztőmező (ahova a h{lót rajzolhatjuk) mérete m{s Petri-h{lós eszközöktől elté-

rően rögzített. H{rom paranccsal v{ltoztathatjuk meg: a View » Fit to net (Alt+F7) parancs az 

éppen szerkesztés alatt {lló Petri-h{ló befoglaló méretéhez igazítja a szerkesztőmezőt, míg a 



PetriDotNet 1.3 felhaszn{lói útmutató 

http://petridotnet.inf.mit.bme.hu/  3 

View » Grow width (Alt+Jobbra) parancs szélességében, a View » Grow height (Alt+Le) parancs 

pedig magass{g{ban növeli meg a szerkesztőmezőt. (Ezek a parancsok az eszközt{rról is 

elérhetők.) A szerkesztőmenő azonban automatikusan növekszik görgetés hat{s{ra, illetve 

ha egy elemet a szerkesztőmező szélére húzunk. 

Alaphelyzetben a szerkesztő (azaz Design) mód van kiv{lasztva. 

Ebben a módban a képernyő bal oldal{n levő oldals{vban l{thatók a 

szerkesztési eszközt{rak, ezekből v{laszthatók ki a h{ló szerkeszté-

séhez szükséges eszközök. A Toolboxban tal{lhatók a beszúrni kív{nt 

elemek: hely, tranzíció, él, token, helyettesítő tranzíció (coarse 

transition – erről egy külön fejezetben részletesebben is írunk). 

Minden szerkesztési művelethez először az adott elemet kiv{lasztjuk a Toolboxban. 

Csomópontok (hely, tranzíció) rajzol{sakor a kiv{lasztott csomópontot a szerkesztőmező 

megfelelő pontj{ra kattintva helyezhetjük le. A Token eszközzel a kezdő token eloszl{s {llít-

ható be: az adott helyre kattintva a helyben levő tokenek sz{ma eggyel nő.  

Él behúz{s{hoz először a kezdő csomópontra, majd a vég csomó-

pontra kell kattintani (ez kicsit eltér a m{s eszközökben gyakori „kezdő-

pontra kattint{s majd húz{s” művelettől). Él rajzol{sakor lehetőség van 

töréspontok beiktat{s{ra is, ehhez a kezdő csomópontra kattint{s ut{n 

sorban a szerkesztőmező megfelelő pontjaira kell r{kattintanunk. A ké-

szülő él a töréspontokkal együtt folyamatosan l{tható. Az utolsó törés-

pont berajzol{sa ut{n kattintsunk a vég csomópontra, ezzel elkészül az él. 

A Select mód kiv{laszt{s{val az egyes elemek (hely, tranzíció, él) kiv{laszthatók és tu-

lajdons{gaik szerkeszthetők. Élek kiv{laszt{sakor az élet alkotó töréspontok is megjelennek 

és szerkeszthetővé v{lnak. Ha egy töréspont rossz helyen van, akkor az él kiv{laszt{sa és a 

töréspontok megjelenése ut{n az adott pontot egyszerűen húzzuk odébb. Ha egy töréspontot 

törölni szeretnénk, akkor ehhez a helyi menüből (az él kiv{laszt{sa ut{n az adott töréspontra 

jobb egérgombbal kattintva megjelenő menüből) a Delete edge point parancsot v{lasszuk. Tö-

réspont utólagos felvételére is lehetőség van Select módban: a Ctrl módosító gomb megnyo-

m{sa mellett kattintsunk az adott él megfelelő pontj{ra, így ott egy új töréspont keletkezik 

(ezt a funkciót a kurzor megv{ltoz{sa is jelzi). 

Ha a be{llít{sok közt a View fülön bejelöljük az Enable edit helper tool lehetőséget, akkor 

egy hely vagy tranzíció kijelölése sor{n kapunk egy szerkesztést 

könnyítő eszközt{rt, mely közvetlenül a kijelölt elem mellett jelenik 

meg. A tranzíció vagy a hely ikonra kattintva 

a kijelölt helyhez kapcsolódó tranzíció ill. hely 

szúrható be, az él ikonnal pedig az adott elem-

elemből kiinduló él készíthető egyszerűen. 

A kiv{lasztott elemek tulajdons{gai az oldals{von elhelyezke-

dő Properties részen szerkeszthetők. Az egyes tulajdons{gokról rö-

vid leír{st kapunk a Properties doboz alj{n. Az elemek tulajdons{gai 

szerkeszthetők a helyi menü segítségével is. Ehhez az adott elemre 

jobb gombbal kattintva megjelenő menüből v{lasszuk ki a Properties 
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menüpontot. 

Egyes tulajdons{gokat anélkül meg tudunk v{ltoztatni, hogy megnyitn{nk a Properties 

lapot. Ilyen lehetőség a m{r említett Token eszköz, amivel a helyekben levő tokenek sz{m{t 

módosíthatjuk. Ezt a lehetőséget gyorsbillentyűk segítségével is haszn{lhatjuk: Select mód-

ban a kív{nt helyet kiv{lasztva a Ctrl+Num+ és Ctrl+Num- billentyűkombin{ciókkal növelhet-

jük illetve csökkenthetjük a hely jelölését. 

Ugyanez a két billentyűkombin{ció élek esetén is működik: Select módban a kív{nt élet 

kiv{lasztva a Ctrl+Num+ növeli, míg a Ctrl+Num- csökkenti az él súly{t. 

 M{sik ilyen egyszerűsítés a tranzíciók orient{ciój{nak (függőleges 

vagy vízszintes ir{ny) megv{ltoztat{sa. Ehhez a Select mód kiv{laszt{sa 

ut{n a Ctrl módosító gomb megnyom{sa mellett kattintsunk az adott 

tranzícióra, aminek az ir{nya függőlegesből vízszintesbe v{lt és a következő 

kattint{sra vissza (ezt a funkciót a kurzor megv{ltoz{sa is jelzi). 

Helyek és tranzíciók létrehoz{sakor az új csomópont neve nem l{tható. Ez a be{llít{s az 

{ttekinthetőséget szolg{lja. A nevek megjelenítését a Properties szerkesztődoboz Name Visible 

tulajdons{ga vezérli, ennek {t{llít{s{val engedélyezhetjük. Kényelmi funkció, hogy ha meg-

v{ltoztatjuk egy csomópont nevét (a Properties dobozban a Name tulajdons{gn{l), akkor a név 

kijelzése automatikusan engedélyeződik. A nevek megjelenítésének {t{llít{s{t gyorsbillentyű 

is segíti: a Select mód kiv{laszt{sa ut{n az Alt módosító gomb megnyom{sa mellett kattint-

sunk az adott helyre vagy tranzícióra, ennek hat{s{ra az adott csomópont neve megjelenik 

illetve a következő kattint{sra megint eltűnik. 

Helyek és tranzíciók esetén lehetőségünk van a csomópont 

nevének elhelyezkedését (a csomópont felett, alatt, tőle balra 

vagy jobbra) megv{ltoztatni a Properties dobozban a csomópont 

Text Align tulajdons{g{nak {t{llít{s{val (négy lehetőség közül 

v{laszthatunk egy legördülő list{ból: Top, Bottom, Left, Right). Természetesen ez is elvégez-

hető egyszerűbben gyorsbillentyűk segítségével: Select módban a kív{nt csomópontot kiv{-

lasztva a Ctrl+Fel, Ctrl+Le, Ctrl+Balra, Ctrl+Jobbra billentyűkombin{ciókkal rendre a csomó-

pont fölé, al{, tőle balra vagy jobbra helyezhetjük {t a név kijelzését. 

 

IV. Hierarchikus hálók kezelése 

Hierarchikus h{ló esetén a Hierarchy dobozban l{tható a h{ló 

felépítése és itt a megjelenítendő alh{lót is ki lehet v{lasztani. A 

program ún. helyettesítő tranzíciók (coarse transition, CT) segít-

ségével kezeli az alh{lókat. A helyettesítő tranzíció lehetőséget ad 

arra, hogy egy modellezett tevékenységet vagy eseményt (amit 

eredetileg egy tranzíció modellezett) finomítsunk, azaz egy alh{lóv{, egy alacsonyabb hie-

rarchia szinten megjelenő Petri-h{ló részletté bontsunk ki. 

Ebből következik, hogy minden alh{lót egy-egy CT reprezent{l a szülőh{lóban. Termé-

szetesen egy ilyen helyettesítő tranzíció „szintaktikailag” is tranzícióként viselkedik, azaz 
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csak helyekhez kapcsolódhat mind bemenő, mind kimenő éleivel. Ezért amikor egy élet hú-

zunk egy szülőh{lóbeli hely és a CT közé, a helyből képződik egy referenciapéld{ny a CT 

{ltal reprezent{lt alh{lóban. A referenciahelyek pontosan ugyanúgy viselkednek, mint szülő-

jük. (A referenciahelyeket a program kékkel jelöli alapértelmezés szerint.) 

Ha egy szülőh{lóbeli helyet a CT-hez kötve nem szeretnénk új referenciapéld{nyt létre-

hozni az alh{lóban, hanem egy m{r létező alh{lóbeli helyet szeretnénk referenciahellyé alakí-

tani, akkor a szülőh{lóbeli hely és a CT közti él behúz{sa közben tartsuk lenyomva a Ctrl 

gombot. Ennek hat{s{ra az él behúz{sa ut{n egy list{ból kiv{laszthatjuk, hogy mely 

alh{lóbeli helyet szeretnénk referenciahellyé alakítani. 

A szülőh{lóban a helyet és a CT-t összekötő él csak egy kapcsolatot vizualiz{l, nem va-

lós él, ezért szaggatott vonallal van feltüntetve és nincs multiplicit{sa. A végén lévő nyilak 

jelölik, hogy az alh{lóban a referenciahelyhez milyen élek kapcsolódnak. 

Péld{ul ha a szülőh{ló és az alh{ló a fenti kettőnek megfelelő, akkor ez ekvivalens az 

alul l{tható h{lóval. 

 

Szülőh{ló 

 

Az alh{ló tartalma 

 

A fenti hierarchikus h{lónak megfelelő egyszintű, „kiterített” h{ló 

A helyettesítő tranzíciók m{solhatók. Amennyiben egy m{solatot hozunk létre egy CT-

ből, m{solat képződik a hozz{ tartozó alh{lóról is. Ez az alh{ló ugyanazokkal a referenciahe-

lyekkel fog rendelkezni, mint az eredeti, kivéve, ha a m{sol{skor a referenciahelyek szülőhe-

lyeiből is kijelöltünk. Ilyenkor a szülőhelyek m{solataira fognak az adott referenciahelyek 

mutatni. Ezt mutatja a következő példa is (a bal oldalon l{tható, hogy melyik elemek voltak a 

m{sol{sn{l kijelölve, a jobb oldalon pedig a beillesztés ut{ni eredmény l{tható): 
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V. Színezett hálók szerkesztése 

V.1. Háló szerkesztése 

Színezett h{lók szerkesztésére a színezetlen h{lókhoz hasonló módon van lehetőség. 

Színezett hely vagy színezett tranzíció beszúr{s{hoz a Toolboxban az Other elements menüből 

v{lasszuk ki a Coloured Place vagy a Coloured Transition opciót. A színezett helyek és 

tranzíciók közt ugyanúgy az Edge eszközzel tudunk éleket létrehozni. 

V.2. Színosztályok kezelése 

A színezett h{lók kezeléséhez szükséges színoszt{lyok 

definíciója is. Ezt a CPN » Token types menüpontban vagy a 

h{ló tulajdons{gai közt tudjuk módosítani. 

Az így megjelenő ablakban l{thatók a defini{lt színoszt{-

lyok. Kétféle színoszt{lyt különböztetünk meg: az egyszerű (single) oszt{lyokat és az össze-

tett (complex) oszt{lyokat. Az egyszerű oszt{lyok enumer{ciók, az összetett oszt{lyok pedig 

egyszerű oszt{lyok Descartes-szorzataként elő{lló színoszt{lyok. 
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Az Add single gombra kattintva új színoszt{ly 

hozható létre, melyhez az al{bbi adatok megad{sa 

szükséges: 

− Long name: A színoszt{ly hosszú neve. 

− Short name: A színoszt{ly rövid neve (ez je-

lenik meg a helyek mellett szerkesztéskor). 

− Minimal value: A színoszt{lyba tartozó leg-

kisebb érték. 

− Maximal value: A színoszt{lyba tartozó leg-

nagyobb érték. 

− Ordered color set: Bejelölése esetén a szín-

oszt{ly elemeire értelmezett az „előző” és a 

„r{következő” rel{ció. 

− Color: A megjelenítéshez haszn{lt szín. 

Lehetőség van tov{bb{ a t{bl{zatban az egyes értékeket elnevezni, így enumer{ció típu-

sú színoszt{lyok is létrehozhatók. Péld{ul Dijkstra híres étkező filozófusainak színoszt{lya a 

követekezőképp néz ki: 
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A Coloured Token Types ablakban az Add complex gombra kattintva új összetett típus 

hozható létre. Ehhez az al{bbi adatok megad{sa szük-

séges: 

− Long name: A színoszt{ly hosszú neve. 

− Short name: A színoszt{ly rövid neve (ez jele-

nik meg a helyek mellett szerkesztéskor). 

− Dimensions: Az összetett színoszt{lyt alkotó 

egyszerű színoszt{lyok (sorrendezett) felsoro-

l{sa. Új színoszt{lyt az Add dimension gombbal 

lehet felvenni. Az aktu{lisan kijelölt színosz-

t{lyt a Delete selected dimension gombbal lehet 

kitörölni. 

− Color: A megjelenítéshez haszn{lt szín. 

Egy hely színoszt{ly{t egyszerűen be{llítani a 

Properties » Coloured set részen lehet, ahol egy legördü-

lő menüből v{lasztható ki a kív{nt színoszt{ly. Emel-

lett a következő fejezetben ismertetésre kerülő módon, a helyen lévő tokenek szerkesztésénél 

is meg lehet v{ltoztatni a hely színoszt{ly{t. 

V.3. Tokenek kezelése 

Egy hely tokenjeinek megv{ltoztat{s{ra a Properties » Initial tokens részen, a … gombra 

kattintva van lehetőség. 
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A megjelenő ablak bal oldal{n felsorol{sra kerülnek a kiv{lasztott helyen szereplő 

tokenek, multiplicit{sukkal együtt. A jobb oldalon l{thatók a hely színoszt{ly{ba tartozó 

tokenek. Új token hozz{ad{s{hoz v{lasszunk ki egy vagy több tokent a jobb oldali list{ból, 

majd nyomjuk meg az < Add one gombot. Ennek hat{s{ra az összes kijelölt tokenből 1-1 dara-

bot adhatunk az aktu{lis helyhez. 

Token törléséhez a bal oldali list{ból v{lasszuk ki a törlendő tokeneket. A Remove one > 

gombra kattintva a kiv{lasztott tokenekből egy-egy darabot törölhetünk, míg a Remove all > 

gombbal az adott token összes péld{ny{t törölhetjük a helyről. 

Egy hely tokenjeit a Properties részen is megadhatjuk szövegesen <számos-

ság>`<érték_vektor> form{ban. (Az <érték_vektor> definíciój{t l{sd V.4. fejezetben.) Emel-

lett haszn{lható az all kifejezés is, amely a helyhez rendelt színoszt{ly összes tokenjét jelen-

ti. 

Péld{k helyes tokenmegad{sra: 1`Aristotle vagy 2`[0,3]++1`[0,0] vagy all 

Lehetőség van ebben az ablakban a hely színoszt{ly{nak megv{l-

toztat{s{ra is a Colour set legördülő menüben. Figyelem, a színoszt{ly 

megv{ltoztat{sa törli az adott helyen lévő összes tokent! 

Az egyes helyeken lévő tokeneknek csak a sz{moss{ga l{tható a 

h{lóban. Bővebb inform{cióhoz v{lasszuk ki a View » Show coloured 

tokens form parancsot. Az így megjelenő ablakban l{thatóv{ v{lnak an-

nak a helynek a tokenjei, amelyre az egérrel r{mutatunk. Az ablak De-

sign és Simulation módban egyar{nt haszn{lható. 

V.4. Élkifejezések megadása, változók kezelése 

A színezett h{lók dinamikus működéséhez szükséges az egyes élekre élkifejezéseket ír-

ni. Ezek a tokenek {raml{s{t szab{lyozz{k. 
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Egy kiv{lasztott él élkifejezését a Properties / Arc expression részen lehet megadni. Egy 

élen kiz{rólag v{ltozók vagy konstansok szerepelhetnek. Amennyiben több v{ltozó is szere-

pel, azokat ++ karakterekkel kell elv{lasztani. Azaz ilyen éleken az al{bbi ArcExpr kifejezések 

{llhatnak: 

<ArcExpr> ::= <érték_vektor> | <ArcExpr> ++ <érték_vektor> 

<érték_vektor> ::= [<érték>, <érték>, …] 

A kapcsolódó helyhez rendelt színoszt{ly dimenziój{nak megfelelő 

sz{mú értéknek kell szerepelnie. Egyszerű színoszt{ly esetén a szögle-

tes z{rójelek elhagyhatók. 

<érték> ::= <változó> | <konstans> 

Péld{k helyes élkifejezésre: ph vagy fb++fj vagy [p,q]++[r,s] 

Élkifejezéseket megad{sa előtt {llítsuk be a kapcsolódó hely színoszt{ly{t. Ellenkező 

esetben a program hib{t jelez az élkifejezésre, b{r amennyiben a szimul{ció megkezdése előtt 

a hely színoszt{lya be{llít{sra kerül, ez semmilyen gondot nem okoz. 

A tokenmozg{s szab{lyoz{s{nak m{sik eszköze a színezett tranzíciókhoz rendelhető őr-

feltétel, melyet a Properties / Guard részen lehet megadni. Ennek form{ja a következő: 

<Guard> ::= <kifejezés> | <Guard> <bool_operátor> <Guard> 

<bool_operátor> ::= ’&&’ | ’||’ 

<relációs_jel> ::= > | < | >= | <= | = | != | <> 

<kifejezés> ::= <érték> <relációs_jel> <egész_szám> | 

<érték> <relációs_jel> <érték> 

<érték> ::= <változó> | succ <változó> 

Péld{k helyes őrfeltételre: fb=succ fj vagy fb > 2 vagy fb>2 && fj<1 

A kifejezésekben szereplő v{ltozók típus{t előre defini{lni 

kell. Ezt a CPN » Variables menüpontra kattintva vagy a h{ló tu-

lajdons{gain{l lehet megtenni. 

A megjelenő ablakban felsorol{sra kerülnek a defini{lt v{l-

tozók típusukkal együtt. Ezeket szerkeszteni (Edit) és törölni 

(Remove) lehet, illetve lehetőség van új v{ltozó felvételére is (Add). V{ltozók kiz{rólag egy-

szerű színoszt{lyokhoz vehetők fel. 
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V.5. Ismert limitációk 

A színezett h{lók kezelése fejlesztés alatt {ll. Az al{bbi funkciók hi{nyoss{ga ismert, 

implement{l{suk folyamatban van. 

− Jelenleg nem lehet színezett hierarchikus h{lót létrehozni. 

− Nem köthetők össze színezetlen helyek és színezett tranzíciók. 

 

VI. Petri-hálók ellenőrzése 

Petri-h{lók ellenőrzésére alapvetően kétféle lehetőséget kín{lkozik: a szimul{ció (token 

j{ték) és a h{ló analízise (dinamikus/viselkedési tulajdons{gok vizsg{lata, invari{nsok sz{-

mít{sa, struktur{lis tulajdons{gok felderítése, stb.). Ezek közül beépítve a PetriDotNet prog-

ram a szimul{ció eszközét kín{lja fel, az analízis elvégzésére pedig a külön telepíthető kiter-

jesztések (add-in) t{mogat{s{val ad lehetőséget. 

VI.1. Szimuláció, token játék 

Szimul{ció módban lehet a h{ló működését ellenőrizni. A szimul{ció a programban két-

féle form{ban érhető el: az interaktív, lépésenkénti szimul{ció (m{s néven token j{ték) és a nem 

interaktív szimul{ció avagy futtat{s. 

Token j{ték esetén (Step by step üzemmód) az adott {llapotban 

engedélyezett tranzíciók a jó l{thatós{g kedvéért piros kerettel és pi-

ros sraffoz{ssal vannak jelölve. Ebben a lépésenkénti szimul{ciós 

módban egyesével tüzelhetjük az engedélyezett tranzíciókat a kiv{-

lasztott tranzícióra kattintva. Ugyanezt érhetjük el a kív{nt tranzíció 

nevét a lenti Choose from list: list{ból kiv{lasztva és a Fire selected 

gombra kattintva. A Step one gombbal véletlenszerűen v{lasztunk 

egyet tüzelésre az engedélyezett tranzíciók körül. A Reset net gomb 



PetriDotNet 1.3 felhaszn{lói útmutató 

http://petridotnet.inf.mit.bme.hu/  12 

alaphelyzetbe {llítja a h{lót, azaz vissza{llítja az a kezdő tokeneloszl{st ({llapotot), ami a 

szimul{ció indít{sakor volt érvényes. 

 

A szimul{ciós szerkesztődoboz alsó Run fülével v{lthatunk nem 

interaktív vagy futtat{si üzemmódba. Ebben a módban (adott idő-

közönként) ismétlődő tüzelést indíthatunk a Run gombbal. A h{ló a 

Tick interval-ban be{llított időközönként lép a következő {llapotba 

(azaz tüzel egyet). A konfliktusokat a program véletlen v{laszt{ssal 

oldja fel, teh{t ebben a módban az {llapottér egy trajektóri{j{t j{rjuk 

be. A Transitions fired last mezőben az utolsó néh{ny lépésben tüzelt 

tranzíciók nevei l{thatók. Ha az Automatic logic time step be van jelöl-

ve, a h{lóbeli idő úgy működik, mint egy logikai óra. Ha nincs beje-

lölve, akkor a h{lóbeli idő a Tick interval-ban be{llított időközönként 

halad előre. 

A Large scale statistics nevű kiegészítő (add-in) beépülő modul segítségével szintén nem 

interaktív szimul{ciót futtathatunk a h{lón, majd a fut{s eredményei alapj{n készült statisz-

tik{t l{thatjuk a modul ablak{ban: 

  

VI.2. Analízis 

A h{lók analízisére két lehetőség van. Egyrészt haszn{lható a berlini Humbolt Egyetem 

Informatikai Intézete {ltal fejlesztett INA (Integrated Net Analyzer, honlapja: 
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http://www2.informatik.hu-berlin.de/lehrstuehle/automaten/ina/) program. Ez .pnt form{-

tumú f{jl bemenetet v{r, amelybe az aktu{lis h{lót a PetriDotNet export{lni tudja az Add-in » 

Export » .pnt export menüpont segítségével. 

M{srészt a programhoz mellékelve vannak bizonyos analízis modulok. Az Add-in » 

Analysis » Invariant analysis menüpont segítségével P-invariánsok és T-invariánsok kereshe-

tők a Martinez-Silva algoritmus segítségével. 

Ezen kívül lehetőség van modellellenőrzésre az Add-in » Analysis » Model checking me-

nüpontban, amennyiben ez a beépülő modul külön telepítésre került. Ebben a modulban az 

{llapottér szimbolikus feltérképezése ut{n egy CTL kifejezés adható meg az al{bbi ablakban. 

Ezt a program kiértékeli és igaz/hamis v{laszt ad. 

 

A kifejezésekben CTL tempor{lis oper{torok és a Petri-h{ló helyeinek tokensz{maira 

felírt kifejezések szerepelhetnek. Ezek tetszőlegesen z{rójelezhetők, összekapcsolhatók ÉS és 

VAGY oper{torokkal, valamint egym{sba {gyazhatók. 

Az érvényes kifejezések form{lis definíciója: 

<CTL_kifejezés> ::= <operátor>(<kifejezés>) |  

<bin_operátor>(<kifejezés> <bin_elválasztó> <kifejezés>) 

<kifejezés> ::= <CTL_kifejezés> | 

<hely_kifejezés> | 

!<kifejezés> | 

<kifejezés> <bool_operátor> <kifejezés> | 

 

<operátor> ::= EX | EF | EG | AX | AF | AG 

<bin_operátor> ::= EU | AU | EW | AW | ER | AR 

<bin_elválasztó> ::= u | w | r 

<hely_kifejezés> ::= <hely_ID> <relációs_jel> <egész_szám> 

<relációs_jel> ::= > | < | >= | <= | = | != | <> 

<bool_operátor> ::= ’&’ | ’|’ 

A <hely_ID> egy Petri-h{lóbeli hely ID-ja vagy neve. Ezek az ablak tetején l{tható lis-

t{ból kiv{laszthatók és az Insert gombbal be is szúrhatók a kurzor aktu{lis pozíciój{ba. 

Amennyiben egy rel{ciós jelet és egy sz{mot is kiv{laszt, majd az Insert full expression gomb-

http://www2.informatik.hu-berlin.de/lehrstuehle/automaten/ina/


PetriDotNet 1.3 felhaszn{lói útmutató 

http://petridotnet.inf.mit.bme.hu/  14 

ra kattint, egy teljes <hely_kifejezés> szúrható be a kifejezésbe. A szerkesztést 

szintaxiskiemelés is segíti. 

 

Egy érvényes kifejezés l{tható a következő képernyőképen: 
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VII. A kezelői felület részletes leírása 

VII.1. A PetriDotNet főablakának felépítése 

 

 

 

VII.2. Főmenü 

 

A menü felépítése 

− File 

 New: Új h{lót hoz létre. 

 Open: Megnyit egy h{lót f{jlból. 

 Close: Bez{rja az aktu{lis h{lót. 

 Save: Menti az aktu{lis h{lót. 

 Save As: Menti az aktu{lis h{lót m{s néven vagy m{s form{tumban. 

 Save to bitmap: Elmenti a h{lót .png form{tumban. 

Főmenü 

Selection eszközt{r 
Fő eszközt{r 

Toolbox panel 

  Tulajdons{gpanel 

Hierarchia panel 

Szerkesztőterület 

V{lt{s tervezési és szimul{ciós mód közt 

Szerkesztő oldals{v 
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 Save to SVG: Elmenti a h{lót vektorgrafikus (Scalable Vector Graphics, .svg) 

form{tumban. 

 Exit: Bez{rja a programot. 

− Edit 

 Undo: Visszavonja az utolsó műveletet. 

 Redo: Megismétli az utolsó visszavont műveletet. 

 Cut: Kiv{gja a h{ló kijelölt elemeit. 

 Copy: Kim{solja a h{ló kijelölt elemeit. 

 Paste: Beilleszti a v{gólapra m{solt elemeket. 

 Delete: Kitörli a h{ló kijelölt elemeit. 

 Select All: Kijelöli a h{ló összes elemét. 

− View – ebben a menüben lehet az oldals{vban levő szerkesztődobozok l{thatós{g{t 

és a szerkesztőmező méretét be{llítani 

 Toolbar: Mutatja vagy elrejti a fő eszközt{rat 

 Selection toolbar: Mutatja vagy elrejti a Selection eszközt{rat 

 Status bar: Mutatja vagy elrejti a st{tuszsort 

 Toolbox: Mutatja vagy elrejti a Toolbox-ot 

 Property pane: Mutatja vagy elrejti a Properties dobozt 

 Token game pane: Mutatja vagy elrejti a tokenj{ték doboz{t 

 Overview: Mutatja vagy elrejti a h{ló {ttekintő képét 

 Design area size: Be{llítja a h{ló alapterületét. 

 Grow width: Megnöveli a h{ló alapterületét vízszintes ir{nyban. 

 Grow height: Megnöveli a h{ló alapterületét függőleges  ir{nyban. 

 Fit to net: A h{ló alapterületét az elemekhez igazítja. 

− Insert 

 Place: Beszúr egy helyet a következő egérkattint{s pozíciój{ba. 

 Transition: Beszúr egy tranzíciót a következő egérkattint{s pozíciój{ba. 

 Edge: Beszúr egy élet a következő két egérkattint{ssal kijelölt elem közé. 

 Token: Eggyel növeli az egérkattint{ssal kijelölt helyen levő tokenek sz{m{t. 

 Default cursor: Kijelölés módra v{lt. 

− CPN 

 Token types: A színezett h{ló színoszt{lyai adhatók meg. 

 Variables: A színezett h{lóban haszn{lható v{ltozók adhatók meg. 

− Mode 

 Design mode: Szerkesztés módba v{lt. 

 Token game simulation: Token j{ték (szimul{ció) módba v{lt. 

− Tools 

 Options: A program működését itt {llíthatja be. 
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− Add-in – ebben a menüben jelennek meg a program kiegészítői, amelyek a program 

melletti add-in könyvt{rban tal{lhatók. 

− Window – ebben a menüben tal{lhatók a megnyitott h{lók ablakainak {trendezésére 

szolg{ló menüpontok 

− Help 

 Send error feedback: Visszajelzést küldhet egy hib{ról. 

 About: Itt t{jékozódhat a program verziósz{m{ról. 

VII.3. Fő eszköztár 

 

 Új 

 Megnyit{s 

 Mentés 

 Kiv{g{s 

 M{sol{s 

 Beillesztés 

 Törlés 

 Visszavon{s 

 Újra 

 Szerkesztés módba v{lt{s 

 Token j{ték (szimul{ció) módba v{lt{s 

 Megnöveli a h{ló alapterületét vízszintes ir{nyban. 

 Megnöveli a h{ló alapterületét vízszintes ir{nyban. 

 A h{ló alapterületét az elemekhez igazítja. 

 Be{llít{sok 
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VII.4. Selection eszköztár 

 

 Az aktu{lis kijelölésből kiv{lasztja a tranzíciókat. 

 Az aktu{lis kijelölésből kiv{lasztja a helyeket. 

 Az aktu{lis kijelölésből kiv{lasztja az éleket. 

 Kijelöli az aktu{lis h{ló összes elemét. 

 Megszünteti a kijelölést. 

VII.5. Tulajdonságpanel (Property pane) 

A tulajdons{gpanelen az al{bbi tulajdons{gok {llíthatók be az egyes elemekhez: 

 H{ló    Tulajdons{g leír{sa 

BorderColor  + + + Az elem körvonal{nak színe. 

Capacity  +   A hely kapacit{sa. 

Coordinate  + +  Az elem pozíciója 

Distribution   +  
A tranzíció tüzeléséhez rendelt valószínűségi 

eloszl{sa. 

FillColor  + + + Az elem kitöltőszíne. 

Id + + + + Az elem egyedi azonosítója. 

Name + + +  Az elem neve. 

Name visible  + +  A csomópont nevének l{thatós{ga. 

Orientation   +  A tranzíció ir{nya (függőleges vagy vízszintes). 

Points    + Az él közbenső pontjainak koordin{t{ja. 

Priority   +  
A tranzíció priorit{sa. (Alapértelmezés szerint 

100, minél nagyobb sz{m, ann{l előbb tüzel.) 

Prohibitive    + True, ha az él tiltó él. 

Text align  + +  A csomópont nevének elhelyezkedése. 

Tokens  +   A hely tokensz{ma a szimul{ció kezdetén. 

Weight    + Az él súlya (multiplicit{sa). 

Az elemekre jobb gombbal kattintva előhívható tulajdons{gablakban ugyanezen tulaj-

dons{gok {llíthatók be. Ez az ablak a Pin gombra kattintva rögzíthető a kényelmesebb szer-

kesztés érdekében. Többszörös kijelölésnél azok a tulajdons{gok l{thatók, mellyel az összes 

kijelölt elem rendelkezik. 

VII.6. Beállítások 

A be{llít{sokban a program sz{mos tulajdons{ga testre szabható. A be{llít{sok automa-

tikusan mentésre kerülnek. 

− Editor 

 Show element names: Ki- vagy bekapcsolható az elemek nevének kiír{sa. 
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 Edge sections arrow cap: Be{llítható, hogy a törtvonalú éleknél minden törés-

pontn{l legyen nyílhegy vagy sem. 

 More visible selection: Ki- vagy bekapcsolható a jobb l{thatós{gú kijelölés. Be-

kapcsolva az elemek h{ttere lesz színes kijelöléskor, kikapcsolva csak a körvo-

naluk színeződik {t. 

 Edge arrow size: Be{llítható, hogy mekkora legyen a nyílhegyek mérete. 

 Align to grid: Ki- vagy bekapcsolható, hogy az elemek illeszkedjenek-e a se-

gédh{lóhoz. 

 Show grid: Ki- vagy bekapcsolható a segédh{ló megjelenítése. 

 Grid style: Be{llítható a segédh{ló típusa (négyzetr{cs vagy pontok). 

 Grid width: Be{llítható, hogy milyen t{vol legyenek egym{stól a segédh{ló 

pontjai vízszintesen. 

 Grid height: Be{llítható, hogy milyen t{vol legyenek egym{stól a segédh{ló 

pontjai függőlegesen. 

 Add multiple elements: Be{llítható, hogy egy elem beszúr{sa ut{n maradjon-e 

az editor beszúr{s módban vagy visszatérjen kijelölés módra. 

 Default transition orientation: Be{llítható, hogy egy beszúrt tranzíció alapér-

telmezés szerint függőleges vagy vízszintes ir{nyú legyen. 

 Cut/copy edges’connecting nodes also: Ki- vagy bekapcsolható, hogy mi tör-

ténjen élek m{sol{sakor (m{solódjanak-e a végpontok is). 

 Delete edges becoming orphan also: Ki- vagy bekapcsolható, hogy mi történjen 

élek végpontj{nak törlésekor. 

− View 

 Desing area: Itt be{llítható, hogy a szerkesztőterület alapértelmezett mérete 

mekkora legyen, illetve mekkora egységekben lehessen növelni. 

 Panels: Itt be{llítható, hogy alapértelmezés szerint mely panelok legyenek l{t-

hatók a program indul{sakor. 

− Token game 

 Default tick interval: Be{llítható a folyamatos tüzelés esetén a két tüzelés közt 

eltelő időintervallum alapértelmezett hossza. 

 Default token game mode: Be{llítható, hogy alapértelmezés szerint melyik 

tokenj{ték mód legyen aktív. 

− Disk, memory 

 Default file type: Megadható, hogy alapértelmezés szerint bin{ris vagy XML 

form{tumba mentsen a program. 

 Memory: Itt korl{tozható a visszavon{s és újra műveletek sz{ma. 
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VIII. Add-inek 

A program t{mogatja add-inek (kiegészítő modulok) haszn{lat{t. Az ilyen kiegészítőket 

a program add-in könyvt{r{ban kell elhelyezni. 

 

IX. Hibák bejelentése 

A program folyamatos fejlesztés alatt {ll, így sajnos hib{k is előfordulhatnak benne. Kö-

szönettel vesszük, ha a felmerülő hib{kat jelzi a program Help » Send error feedback felületén 

keresztül vagy a petridotnet@inf.mit.bme.hu e-mail címre. Ugyanerre az e-mail címre v{rjuk a 

javaslatokat, ötleteket is. 
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